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User Guide – LINK 4.1 V1.4 
 

 

This guide covers the basics of the LINK App from the end user perspective. 

There is a separate guide for editing.  

For additional guides and quick tips, please see our Document Center. 
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LINK Home Screen 
 

 

This is your starting place, the LINK home screen. 

Tap on a tile to use Outlook, Document Management, OneDrive, Windows files shares, My Files local storage, the firm 

portal, SharePoint, and web applications.  
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Home Screen Icon Legend 
 

 

From the LINK home screen tap on a tile to use Document Management, Outlook, the firm portal and other resources.  

 

 

Use the three-bar menu to: 

-Logout - your admin may ask you to do this occasionally if there is an update to the server software. This is a full logout 

which requires login with your Active Directory password or SSO. In contrast, the Quick Lockout uses Face ID or Touch ID 

to log back in.  

-Go Online/Offline – will prompt you to login for Offline access. 

-Reset your LINK Pincode. The LINK Pincode is rarely used. It is used when offline or as a last measure to log-in. Reset 

here or ask your LINK admin to reset from the LINK Controller console.  

Quick Lockout  
Lock your device quickly. 
Use Touch ID or Face ID to 
re-authenticate.  

Three-bar Menu: 
-Logout 
-Go Offline/Online 
-Reset LINK Pincode 
 

Home 
Return to this Home screen 

My Files 
Local encrypted storage with 
offline and online access.  
Red badge indicates how many 
files are edited but not checked-
in.  

Tab Navigation  
Use tabs to switch between 
open files and/or applications. 

Settings 
Set a default app, Grid or List 
Mode, clear browser cache, view 
app version, more 
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Grid View or List View and Light and Dark Modes 

 
I. The LINK Home Screen now supports Grid View (also known as the Tiles View) or List View.  

Change to Grid or List View from the LINK Home Screen Settings tab (see below). 

II. LINK supports the device OS Light and Dark mode in the device Settings (see below). 

 

         
 

        
 
 

 
We suggest Grid View for tablets and List View for smartphones (to be able to thumb-scroll).  
It is strictly the preference of the user. 
 
There are 4 total display options per device:  
Grid Light, Grid Dark, List Light, List Dark 
 



 

Mobile Helix, Inc.  Page 7 of 80 LINK User Guide 4.1 

 

 

LINK Settings from the LINK Home Screen – Grid and List Setting 

 

 
 

 
 
  

Default App 
Set an app which LINK will open 
to automatically.   

Apps mode 
Select Grid (Tile) or List view  

Page mode 
Display a file as 1-up or 2-up on 
iPads. 
Note: this can also be changed in 
the PDF viewing settings.  
  

Client version 
App version number 
  

In-app notifications 
Toggle on or off 
  

In-app help 
Toggle on or off 
  

Tiles Style 
Select Card or Floating style  

Option to view Office Tutorial  
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iOS and Android Light and Dark Mode Support 
 

Light and Dark Mode are Set in the iOS “Display & Brightness” or Android “Display” Settings  

       
   iOS Setting      Android Settings 

Quick Fix Tip 
 

1. If an app is not rendering properly, “Clear browser cache.” 

This takes seconds.  

2. If an app is not syncing properly or if you are experiencing something which was not fixed by #1, then “Clear all 

local data.”  

This reloads all of the data in the app from the server. Therefore, it could take minutes to reload. 

Always try “Clear browser cache” first.  

See the Troubleshooting Guide for more tips. 
 

 

 
 

 
 

 

 

 

 

 
Press and hold on the tile icon for the 
appropriate app. Menu will appear.  
 
Select “Clear browser cache” or  
“Clear all local data.”  
 
 
 
 
 
 

https://mobilehelix.atlassian.net/l/cp/QwdMTjzG
https://vimeo.com/manage/videos/611039910
https://vimeo.com/manage/videos/611039910
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LINK Document Viewer Features 
 

Wherever you open a document in LINK: DMS, another File Share, My Files, or as an attachment to email, the document 

will open in the LINK Document Viewer, as shown below.  

 

 

 

 

 

   

Document Index 
View outline, bookmarks, more 

 

Search document 

Grid view of file 

Icon Legend Help 

Add document to My Files 

Close document.  
If you have made a change, action menu will be 
displayed.  
 

Document Grid View (small thumbnails) 

Edit or Annotate 

Slide Handle for split screen mode (tablet only) 

Thumbnails – tap on document to make 
thumbnails appear or disappear 

Tabbed Files & Apps 
(iPad only) 

Bookmark page 

Jump to a page 

Page Settings Gear Icon 

Scroll, Transition, Appearance 
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PDF Page Settings and Action Icons 
 

 

 

 

 

 

  

Settings for Page View – detail below 

 

Document action icons, left to 
right: 
- AirPrint 
- Email 
- Import/Check-in to DMS / ECM 
- Save to a folder in My Files 
- Save to My Files 
 
 

  

View pages side by side or one 

page at a time. 

Add document to My Files 
 
Tap on this link to organize in My Files. 
You can add the document to a current 
folder or create a new folder. 

Settings for Page View:  

 

Transition – how the page will 

move on screen 

Mode - number of pages 

displayed 

Scroll Direction  

Fitting – zoom in or out 

Appearance - Light or dark 

mode 

Brightness Level 
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PDF Grid View and “Document Edit” 
 

 

 

 

Grid View 

 

 

 

 

 

 

PDF Grid View / Return to Page View  
Tap to go to Grid View.  

Document Edit Menu  
When you are in Grid View, tap the Pencil to 
display the Document Edit Menu (shown 
below). 
 
 Display Bookmarked Pages Only 

Display Annotated Pages Only 
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Document Edit Menu – Manage PDF Pages 
      

These features are known as “Document Edit.” Here you can add, subtract, move pages, and more.   

1

 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

Document Edit Features 

1. Add a page 

2. Delete selected page(s) 

3. Duplicate selected page; paste to right 

4. Rotate, landscape or portrait 

5. Export selected pages 

6. Select/Deselect all pages 

7. Cut page 

8. Copy selected page(s)  

9. Paste Page(s) (paste cut, copied pages) 

10. Undo  

11. Redo 

12. Checkmark – Close menu 

13. Dots – press and drag to move menu to 

other side 

 

Press and slide to move a page.  
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Multi-tasking with Split Screen Mode 
 

 

 Use Split Screen Mode and Multi-tab View in DMS or Other File Share 

 

 

          

 

 

                              

 

 

 

 

 

From a folder, tap on two or more files to 

open in multi-tab view.  

Split screen is currently supported for iPad 

only.  

Adjust split screen ratio by pressing and 

dragging slider handle.    

Multi-select Mode 

Tap two (or more) radio buttons. 

Then use the icons to select: 

Compare, Send, Save to My Files, or Open 

Drag and Drop Files or Applications 

Move files to the other screen by pressing 

and dragging.  

https://vimeo.com/530085343
https://vimeo.com/530085343
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Use Split Screen in Email 

 

 

           

 

 

 

      

  

Tap on attachment to open it.   File will open on the right side.   

For iPads only.  

When there is more than one attachment: 

-Tap the Ellipsis menu (green) 

-Select: 

View All – to open all files 

Upload All – to import to DMS 

Download All – to save all to My Files   

The files will open in tabs on the right. 

You may press to drag and drop files and 

applications from one side to the other.    
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Use the Home Tab to Navigate to Another App in LINK – iPad Only  
 

Use the “Home” tab to go back to the LINK home screen and navigate to another application or resource.  

 

        

 

  

     

   

 

  

Tap the “Home” tab to go to the LINK home 

screen. 

 

 

Email is open on the left. 

DMS is also open in a tab on the left.  

 

Now from the Home Screen on the left, tap the 

Outlook Email tile.  

 

You may press to drag and drop a tab to the 

other side. 

 

DMS 
OPEN FILE 

IN DMS 

EMAIL 
OPEN FILE 

IN DMS 
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Turn Split Screen Mode Off and On 

 
Split Screen mode is on by default. Toggle Split Screen to be off by default. 

The Split Screen handle is always present on the right to use when needed. 

 

        

From the DMS folder view, tap the Gear icon.   Toggle “Open files in split screen mode” to off or on.   

       Save, tap Diskette in the upper right.  

       Note: Split Screen mode is on by default 

 

     

Split Screen mode is on.    Split Screen mode is off. 

Files and apps appear on two screens.   Only one file or app is displayed, however, multiple files may  

Files and apps may be dragged and dropped  be open in the multiple tabs at the top.  

to the other side.      View two pages: Tap the Gear icon > Page Mode > Double 
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Tips for Using Split Screen 
 

Split screen:  Slide all the way to the right 
 

When you slide the split screen handle all the way to the right, the tabs on the right are not closed or lost. Think of it as 

those tabs moving off the screen to the right.  

When you slide the split screen handle back to the left, those tabs will reappear.  

Also, because sliding to left from the far-right position clones the open tab on the left, you will also have a new tab on 

the right which is a clone of the screen on the right.  

 

               

  
Two files are open on the 

right side.  

  

Slide split screen handle all 

the way to the right.  

Think of those two files as 

being off the screen to the 

right.  

  

Slide handle back to mid-

screen. 

Now the two files reappear 

on the right. 

Also, since sliding to the left 

from the far-right clones the 

open tab on the left, there 

will be a new tab open on 

the right which is a clone of 

the open tab on the left.  
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Document Management  
 

Find a File in DMS 
 

 

Tap on the DMS tile. 

 

      

  

 

 

 

 

 

 

 

 

 

 

 

 

Folder View Search  

Top Level Folders in DMS 

Three ways to find a file:  

I. Browse to any file by tapping on 

successive folders.  

II. Search – Tap Search Glass icon to go 

to Search.      

III. Use “Workspace & File Lookup” 

(more info below) 

 

Unique Folders in LINK 

• E-mail Folders: Attachments to 

emails in Outlook folders 

• Inbox Attachments: Attachments to 

emails in the Outlook inbox 

 

GO TO HOME SCREEN BROWSE 

EMAIL 

SEARCH 
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Open a File in DMS 
 

       

 

 

 

List All Files in a Workspace or Folder 

You can list all files in a Client/Matter Workspace or in any folder. You can also save the folder to your favorites for quick 

access. If you select “List All Files” you have the option to annotate the list, then Air Print, Email, Upload to DMS, or Save 

to My Files (highlighted below). If you select “Add to Favorites” the folder will appear in the My Favorites folder on the 

main page of your DMS. 

                  

Tap the Ellipsis menu of the folder.  

 From the displayed list, tap the Pencil icon to annotate.  

Tap “List All Files” or “Add to Favorites”   Then, tap the page to make the action icons appear below.  

Or tap the X in the upper right for the actions menu.  

 

Tap on a file name to open the file.  

  

File is displayed, including any redlines. 
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Document Ellipsis Menu 

 

         
 

Tap on the Ellipsis icon to display menu.    Document actions are displayed.  

 

Options from the Ellipsis Menu – may vary per firm  

• Checkout & Edit 

• Checkout & Take Offline 

• Accept & View (as a clean copy) 

• Save to My Files (encrypted storage in LINK)  

• Copy File 

• Rename File 

• Open Old Version 

• Compare Versions 

• Compare To 

• Email Copy 

• Email Link  

• Email PDF 

• Add to Favorites 

• Show Properties 

• Optional feature: Open in Another App – With this law-firm configurable option you can open a file in a 3rd-party app 

outside of LINK.  The firm IT/Security department must review security ramifications before enabling this option in 

the LINK Controller. For help write to: support@mobilehelix.com  

 

 

 

  

mailto:support@mobilehelix.com
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Folder Page Icon Legend 
 

  

 

 

 

Multiple File Actions 

1. Check two or more radio buttons on the left. 

2. Choose an action: 

a. Compare two files 

b. Email all 

c. Download all to My Files encrypted storage in LINK 

d. Open – open all marked files multi-tabbed view on a tablet 

 

Back to previous screen  

Go to top folder level in 
DMS  

Sort by Last Modified, 
Name, Type, etc.   

Refresh page  

Settings 
Font size, open files in Split  
Screen Mode, more   

Filter by file name 
Type in a few letters 

Create and add to this folder 
at new Note, Photo, more 
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Email a File from the Document Viewer 
 

        

View the open document. Select “All open files” or “Current file.” 

Tap the Envelope icon. Next, select “This page” or “Full document.”  

 

        

 

To view file options, tap on the Ellipsis menu.  

You may Preview, Delete, Rename, more.  

You may select to send the attachment as: “Original” (e.g., .docx), “Document Link” (.nrl) or PDF.  

Finish composing the email.  

Tap the Paper Airplane icon to send.  

Reference: Compose & Send an Email.  

 

 
 

Tap on the Ellipsis icon for 
file options.   
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.MSG Files in DMS 

 

 

                   

To open a .MSG file, tap on it.  If the original email had an attachment, the .MSG file 

will also have a document embedded.  

Tap on the blue hyperlink to view the attachment.  

Use arrow to Reply, Reply All, or Forward  

 

Reply, Reply All, & Forward an .MSG from the Ellipsis Menu 

 

 

 
To Reply, Reply All, or Forward a .MSG file: 

1. From the open .msg file use the arrow icons (upper right).  

2. From the Folder (list) view, tap on the Ellipsis menu and select the desired option.  
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Search for a Document in DMS  
 

LINK uses the DMS search APIs. Therefore, you will get the same search engine as you have in DMS on your PC.  

 

          

Tap on the Search Glass icon.     Enter your search criteria, then tap “Run Search” or Enter. 

 

            

SEARCH TIPS:  

• Where there is a field in blue font, you have two choices: 

o Type a few letters in the field, here “En” in “Client.” Options will be displayed in a drop-down menu.  

o Tap on the blue lettering, here “Client.”  A list will be displayed on the right.  

 

• Recent Searches – Your recent searches are saved. Tap “Recent” to display a list of Recent searches. 

 

• Quick Lookup – You can also use Lookup from the DMS Folder screen to go directly to a Client/Matter or to a Doc ID.  
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Workspace & File Lookup in DMS  
 

          

 

Quick lookup for: 

• Client/Matter: Type a few letters of Client and then Matter. Select from drop-down menu. Tap Lookup. 

•  File: Tap “Files,” enter Doc ID. Tap Lookup.  
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Annotate a Document 
 

         

From an open document, tap the     Annotation Toolbar is displayed across the top.  

Pencil icon in the upper right.     Tap on a tool to use it.  

Select “Annotate PDF in Link.”      See Annotation Toolbar Legend below.  

        

Select a tool. Here, the Text Highlighter.   Press on the color dot to change color, thickness, opacity.  

  

  

 

  

After annotation, select an action from the 

icons below: Air Print, Email, Upload to DMS, 

Save to a Folder in My Files, or Download/Save 

to My Files.  

Tap document to display icons.  

 

Or, maybe easier, from the open, annotated 

file, tap the X in the upper left, beside the Gear, 

shown above.  

Action Menu is displayed.   

COLOR DOT 

WHEN 

FINISHED, 

TAP X FOR 

ACTION 

MENU. 

https://vimeo.com/manage/videos/837613293
https://vimeo.com/manage/videos/837613293
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Annotation Toolbar Legend 
 

You may use the Apple Pencil or your finger to annotate in LINK.  

 

To start the annotation: From any open file in LINK, tap the Pencil icon.  

   

 

 

 

 

 

 

This is the Annotation Toolbar. 

You can reposition it on the page, by 

pressing on the “handle” (in green) and 

positioning.  

 

The Toolbar has tabs for additional tools: 

Standard, Shapes, Text Markup, and Insert 

(for signature and stamps/date) 

 

Tool Icons in the Standard Tab (shown) 

include:  

- Pen point: Write with Pencil or 

Finger 

- Marker: Freehand highlighter 

- Eraser 

- Wand: draw a box 

- “T|”: Add text; tap the T, tap the 

document, type text (or dictate) 

- T: Text highlighter 

- T: Press on T; Underline, Squiggly 

Underline, Strikethrough 

- Ellipsis in Circle: “More,” incl Undo 

and Redo, Signature (J), Stamps 

(date/time), Redaction 

- Color dot: change feature color 

- X in square: Close annotation menu 

 

The small triangle at the lower right of a tool indicates that there are more related 

tools.   

Press on the tool with the small triangle to see additional tools.  

Here, press on the T to display the Strikethrough, Squiggle, Underline tools.  
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 Annotation (continued) 

Shapes Tab 

Includes: 

-Arrow 

-Wand – to draw a crisp rectangle 

-Various shapes 

Text Markup Tab 

Includes: 

- Insert Text 

- Comment 

 

 

 

Note: As shown, you can move the 

annotation menu to another position, as 

preferred (left, right, or top). 
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For more information, see Annotation Toolbar Legend for LINK Notes and Document Annotation in the Document 

Center.  

Insert Tab 

Includes: 

-Signature – Tap your signature, then tap the 

document and position. 

To add your signature, tap the +, then sign, 

tap Save, tap Done.  

-Stamps – Tap the Stamp icon.  

Stamps includes time and date stamps. Tap 

the stamp, tap the document and position.  

-Redaction Knife – See the how-to below.  

https://mobilehelix.atlassian.net/wiki/spaces/LDP/pages/141262863/Annotation+Toolbar+Legend+for+LINK+Notes+and+Document+Annotation


 

Mobile Helix, Inc.  Page 30 of 80 LINK User Guide 4.1 

 

Linking an Annotated File (now a PDF) to the Original Word File 
This workflow applies when you annotate a Word document and want to save it to DMS. An annotated Word file will 

now be a PDF and cannot be checked-in with the Word file Doc ID. It will be checked in as a PDF with a new Doc ID.  

Note: If you go to the new PDF in iManage Work > Properties > Related Documents, the original Word file will be listed.  

          

Select a document in DMS to annotate.     Tap the Pencil icon.  

Tap to open the document.     Select “Annotate PDF in Link.” 

 

              

Annotate the document. See more on Annotation HERE.  From the Action Menu, tap the first option, “Check-in  

To import to DMS:      Annotated PDF.”  

1. Tap the X in the upper left of the pane and  

use the Action Menu to check-in. 

2. Or tap in the white space outside the  

document to display the action icons (Print,  

Email, etc.). 
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        Here, you may modify the file name in “New Name.”  

-Navigate to the destination folder.     Change Document Class or Department by tapping on  

-Tap “Save Here.”       the blue text and selecting from menu.    

        Tap the Up Arrow icon to Check-in to DMS.   

   

   

The new file is checked in to DMS (green checkmark).    Related document in iManage Work  

It is now a PDF.        In Work, go to either version, the Word file or the 

It has a new Doc ID.       Annotated PDF. You will find the other file referenced in 

        Properties > Related Documents  
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How to Redact a Word or PDF File 
 

 

       

  

  

  

    

 

 

 

      

 

  

Make one or more redactions on the page. 

If you want to change the redactions, tap on the 

redaction. From the local menu, tap the Trash 

Can.  

Continue redacting.  

From the open doc, tap the Pencil icon to open 

the Annotation Toolbar.  

Tap the “Insert” tab, then tap the Redaction 

Knife icon.  

To change the colors used in Redaction, tap the 

color dot.  

This shows that the Outline color (draft color) is 

red and the Fill Color (final redaction color) is 

black.  

  

To preview the redactions (blacken out): Tap the 

Redaction button (highlighted in green). Then, toggle the 

“Preview Reactions” on.  

If you want to change the redactions, toggle “Preview 

Redactions off.  

Then press on the redaction and tap the Trash Can.  

Continue redacting.  
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When the redactions are as you would like them, 

tap “Redact Current Document.” 

Note: To finally save the redactions to DMS, you 

must check-in the document.  

Here, the “Preview Redactions” toggle is on, therefore, 

redactions are blackened out.  

If you want to change the redactions, toggle “Preview 

Redactions off.  

Then press on the redaction and tap the Trash Can.  

Continue redacting.  

Tap the X when 

finished annotating 

to check-in to DMS.  

-Check the redacted file into DMS. 

-Tap the X in the upper left of the document. Illustrated 

in prior screen. 

-Tap the first option, “Checkin the annotated PDF(s).”  

  

-Select Check-in option. Here selected is “New Version” 

which means same Doc ID with a New Version number. 

- Tap the upload button.  

- Now, go to your folder view and tap on the file to verify 

your redactions.  

-You can find the file in the “Recent Documents” folder.  
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Compare Documents in LINK 
LINK offers both “Tracked Changes” and “Inline text.” Select per each comparison.  

There are several ways to compare documents in LINK.  

 

1. Compare two versions of the same document  
 

       

Tap the Ellipsis menu on the right of the file name. (green highlight)  Select “Tracked changes” or Inline text. 

Tap “Compare Versions.” (orange highlight)    Select the two versions to compare.   

Tap the Checkmark to run the comparison. 

 

 

          

 

 

 

 

 

 

 

 

A comparison summary page is presented on the first page,   Comparison is displayed. 

showing the top 25 changes.       Take actions to Print, Email, save to DMS, file to a 

folder in My Files, or save to My Files, using the icons. 

Tap the X in the upper left to close.  
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2. Compare two Word documents in the same folder 
 

 

 

            

Tap the radio buttons to the left of the two documents.   Tap the Checkmark to run the comparison.  

Tap the Comparison icon in the upper right.    To run a reverse comparison: Tap the Rotate icon. 

   

 

The comparison summary is displayed.    Comparison is displayed. 

The next page is the comparison.    Take actions:  

Use the icons in the lower right: Print, Email, save to 

DMS, file to a folder in My Files, or save to My Files, 

using the icons. 

Tap the X in the upper left to close.  
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3. Compare any two Word documents in DMS 
 

     

 

Tap the Ellipsis menu to the right.     From the overlay, search or navigate to the second  

Tap Compare To.       document. Tap that document.  

 

         

 

To run the comparison, tap the checkmark. (orange)  The comparison summary is displayed. 

To run a reverse comparison, tap the rotating arrows. (green) Take actions to Print, Email, save to DMS, file to a 

folder in My Files, or save to My Files, using the icons. 

Tap the X in the upper left to close.  
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4. Compare an Email attachment to a document in DMS 
 

 

             

Press on the small triangle for more options.   Tap “Compare To.”  

 

      

Tap “Select Original File.”     You can reverse the files by tapping the Rotate icon. 

Search or navigate to the target file.     Tap the Compare icon to run the search.  

Tap on the target file.  
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The comparison summary is displayed.    The comparison is displayed. 

The next page is the comparison.    You may annotate by tapping the Pencil icon. 

        Take action: 

Use the icons in the lower right: Print, Email, save to 

DMS, file to a folder in My Files, or save to My Files, 

using the icons. 

Tap the X in the upper left to close.  
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How to Check-in the Comparison Copy to DMS and LINK to the Original  
 

           

The redlined comparison of two versions is displayed.  

To check the redlined comparison in to DMS, 

tap the Upload icon.  

 

           

 

 

 
 

 

Upload to DMS 

On the Upload screen you may:  

1. Recommended: Change New Name, e.g., append 

“Redlined,” as shown.  

2. To link the Original Doc ID, select “New doc ID.”  

3. Select “Link the imported document to.”  This 

will display the Original document file name.  

4. You may change the Class and Dept by tapping 

on the blue text and selecting new ones.  

5. Tap the upload button.  

 

 

From the overlay on the right, navigate to the folder 

where you want to check-in the comparison version.  

Tap “Save Here.”  

Related Document in iManage Work 

In iManage Work on your PC, go to the Comparison 

file, Doc ID (ex. 34329). 

You will find the Original (33361) file referenced in: 

Properties > Related Documents. 

(You may also do the reverse, go to the Original 

(33361) and locate the Comparison file (34329) in 

Properties > Related Documents.  
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Key to a Checked-out File in DMS 
If a file is checked-out to you, a green check mark will appear on the file icon. 

If a file is checked-out to another person, a red check mark will appear on the file icon.  

If you try to edit a file checked out to someone else, a warning will be displayed, see below. 

       

 

         

 

 

            

  

Top: Green check – checked out to you. 

Bottom: Red check - checked out to someone 

else. 

Tap File Name to open and edit.  

From the open file, tap the Pencil icon. 

Then, tap “Edit in Office.” 

  

Warning message will appear: 

“Cannot edit. This file is check out by <NAME>. 

You cannot edit this file until it is checked in 

again.” 

Note: If you still want to edit a copy of this 

check-out file, go to the Ellipsis Menu to the 

right of the file name and select “Copy and 

Edit.”  

You will check-in as new document with a new 

Doc ID. Then proceed to edit the new Doc ID.  

 

Note: LINK will not let you check-out a file which 

is already checked-out from the Ellipsis menu. 

See above, there is no option for “Checkout & 

Edit” or ‘Checkout & Take Offline” when there is 

a red check mark.  
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My Files  
 

“My Files” is the local, encrypted location for documents. You may view files in My Files when on-line and off-line.   

There are two My Files Action Icons in the lower right of any open file. 

  

 

Tap My Files.  

 

 

  

  

“+” mark – create new Audio, 
Video, Photo, or Note. Also, 
import External Document.  

“?” Icon Legend Help 

Go to LINK Home Screen 

Counter of the number of files 
which have been edited or 
annotated but not checked-in yet. 
These files may be found in the 
“Recently Edited Folder.  
 

 

Save to a personal folder 

in My Files 

Save to Saved Files 

section of My Files 

My Files 
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My Files Icon Legend 
 

 

Files expiration is a policy set by IT. Opening or acting on a doc will reset the expiration window.  

Tap the file name to view a document.  

Days until doc will be expired 
from My Files  
 
This is a firm IT policy. Every 
time a file is opened the 
expiration resets.  

Organize in My Files - 
Tag document  
Create a new tag/folder 
 

Delete document from 
My Files  

Email document  

Upload Icon: Import or 
Check-in a Doc to DMS 
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From the Document View (more information here) you may edit or annotate a file in My Files. 

You can then perform any of the following actions:  

1. AirPrint 

2. Email 

3. Import or check-in a document to DMS or another repository (rectangle with up arrow) 

4. Save to a Personal File in My Files 

5. Save locally to My Files 

Or, tap the X to exit the file. The action menu will be displayed if the file has been modified.  

Exit File 
Action menu will be displayed if 
you have modified the file.  

- AirPrint 
- Email 
- Upload/Check-in to DMS  
- Save to a Personal File in My Files 
- Save/download locally to My Files  
 
 
 

 

Annotate or edit 
See documentation for 
annotation in this document. 
Editing is in a separate document.  
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Act on Multiple Files in My Files 

 

 
 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 
First, tap on the Select button to the right of the item. A 

checkmark will appear. 

When files are selected the group action menu will appear in the 

upper right.  

- Open all files 

- Import/Upload all files to DMS or other file share 

- Email all files 

- Trash all files 
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Add an Audio, Video, Photo, or Note File; Import External Document 
 

   

 

  Tap the Plus “+” sign to create a new file, e.g., Audio or Video file or a new Photo, or to 
add a Photo from the Photo Roll. 
 
Tap Blank, Linked, or Wide-ruled Note to create a new note.  
 
External – this is an easy way to import a file from the Files app or other app to My Files. 
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Create a New Note  
 

There are two ways to create a note in LINK. You can begin in My Files and tap the + in the upper left to add a new note.  

When you select Blank Note or Lined Note from the + menu, a new note will open.  

 

 

Use the annotation menu to handwrite or type a note. For instance, tap the pen point to write.  

- You can write with your finger or Apple Pencil.  

      - You can also type or use the keyboard microphone to dictate.  

- See the Annotation tools here.   

When the note is complete, tap the blue file name to rename or save to a folder. 

Or, tap the X to exit the note. It will save to Recent Files. 

 

 

 

Tap the X to exit the note. It will save to 
Recent Files (or DMS or OneDrive if configured 
by the firm). 
 
 
 Notes are automatically named with “New 
Note” and the date and time. Tap the blue 
text to rename and or save to a folder. 
 
 
 

Notes Annotation Menu 
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If you tap the X to close the Note, a new Note file will appear in the Recent Files section.  

- It will also appear in the Recently Viewed folder. 

If you have not checked-in the file to DMS (or another file share), the file will also appear in the Edited Files folder.   

- Once you have checked the file into DMS or deleted it, it will no longer appear in the Edited files folder.  

From the new file in Recent Files, use the icons to the right to set a new tag, email, import to DMS (or another file 

share), or delete.  

 

Notes may automatically sync to your DMS or OneDrive, as set by the firm. 

Auto-Save: as you create a Note, it will be auto-saved periodically.  

- Even if you close the Note without saving it, the Note will be saved to Recent Files.  

Media File: When you create a new media file (audio or video) from the Plus “+” sign, the media file will automatically 

save to Recent Files in My Files. 

 

Create a Note Using LINK Notes  
 

The other way to create a note is to tap the LINK Notes tile from the home screen. 

Tap the pencil in the lower right and select your action.  

      

 

Follow the same process as above to create your note. 

Notes may automatically sync to your DMS or OneDrive, as set by the firm. 

Also see: 

- LINK Notes Quick Tip  

- LINK Notes Demo Video  

https://mobilehelix.atlassian.net/wiki/spaces/LDP/pages/132120577/LINK+Notes
https://vimeo.com/1057684867
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Using Email in LINK 
 

 

Tap the Outlook tile.  
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Advance Through Email – Two Ways 
 

  

Use the up and down carats to 

advance through email.  

Also, swipe left and right 

through email body to advance 

in either direction.  
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Email Inbox Icon Legend 
 

 

 

 

 

 

 

 

 

 

 

  

File to Outlook or DMS 
Folders 
  

Filter – use multiple 
options 

Sort  

Compose New Email 

Go to Filing History folder 
to find emails recently filed 
to Outlook folders.  

Advance Buttons 

Go to Outlook folders  

Exit to LINK tiles home 
screen  

Set Flag  

Contacts, Tasks, Notes 

Search Email  

Reply, Reply All, Forward 

Multi-selection buttons  

Email Settings  

VIP Indicator  
and button to turn on/off/ 
Blue Is on.  

Calendar 

Trash  
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Email Quick Tips 
 

We have many guides and quick tips for using email in the LINK Document Center.  

Search “email” in the Document Center to see them all. 

 

Here is a partial list of the Email tips and features:  

Email Folders - Hierarchy or Flat (Outlook Folders) 

Preview Attachment Before Sending 

PDF Attachment - Convert Email Attachment to PDF 

Send-and-File - Turn On/Off 

Email Filing History - Find an Email Filed in Outlook 

Email Multi-Selection Mode in the Inbox  

 VIP - Get VIP Alerts 

LINK Undo - Undo an Email Send 

  

https://mobilehelix.atlassian.net/wiki/x/soCVAg
https://mobilehelix.atlassian.net/l/cp/WfXDWzvj
https://mobilehelix.atlassian.net/l/cp/g1XeaChj
https://mobilehelix.atlassian.net/l/cp/C37dfWbP
https://mobilehelix.atlassian.net/l/cp/ULFXuPao
https://mobilehelix.atlassian.net/l/cp/MkjTu6t7
https://mobilehelix.atlassian.net/l/cp/0qzCVYQC
https://mobilehelix.atlassian.net/l/cp/eg1xQi6F
https://mobilehelix.atlassian.net/wiki/spaces/LDP/pages/151453697/LINK+Undo+-+Undo+an+Email+Send
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Email Attachment Actions Including Upload Attachment to DMS 

 

     
 

 

        

 

 

         

Tap on the file icon to 

open the file. 

 

Tap the small triangle 

for the file action 

menu.  

When there are multiple files attached: 

-Tap on the Ellipsis menu  

Select an option: 

-View All – Open all files for viewing (iPad only)  

-Upload All – Upload all files to a folder in DMS or 

other file share 

-Download All – Save all files to My Files (the 

encrypted storage in the LINK app) 

 

Word/Office 

file menu: 

-Edit 

-Add to My 

Files 

-Upload file 

-Accept & 

View (as a 

clean copy) 

-Compare To 

 

PDF file Menu: 

-Add to My Files 

-Upload file(s)  

    to DMS or other file 

share  
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Open an NRL Attachment  
 

Video: Open an NRL attachment and accept redlines 

         
Tap on the NRL attachment icon to open the document.  Document and any redlines are displayed.  

        Tap Pencil icon to edit or annotate.  

        Take actions in the lower right. 

For more information, see LINK Document Viewer Icon Legend. 

 

View NRL with Redlines Accepted 
 

            

 

Tap on the small triangle to the upper right of   Document is displayed with all redlines accepted.  

of the file icon to display menu.        

Tap “Accept & View.”        

For more information, see LINK Document Viewer Icon Legend. 

https://vimeo.com/281529251
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Compose & Send an Email 
 

 

 

 

 

 

 

Tap in the “To:” box.  

Start typing a name, then tap on the target name. 

Or use + symbol for name search.  

 

 

 

 

 

 

 

Email Compose Icons 
 

 

View Calendar  

-Tap to view Calendar.  

-When finished viewing Calendar, tap X to return to the Email Compose screen. 

Attachment, Urgent, Send-and-File 

-Add a file from DMS, new photo, or image from photo album – Paper Clip 

-Mark as Urgent – Exclamation Point is red when turned on 

-Send-and-File – folder icon is green when Send-and-File is turned on 

 

 

 

 

Tap the Pencil icon to 

compose a new Email.  

 

https://vimeo.com/manage/videos/837629021
https://vimeo.com/manage/videos/837629021
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Email Editing Options 

- “A”- Font-related 

- “¶” - Page and paragraph formatting 

- “+” - Add table, symbol, add a line above the 

text, new photo, image from photo roll (on 

Android, use paperclip to add photos), Zoom 

link, or Teams link  

-Undo 

 

To add a Zoom or Teams link to an Email 

1. Tap the + icon on the Edit panel. 

2. From the expanded menu tap on either 

the Zoom (video camera) or Teams icon. 

Note: On a tablet, the Zoom & Teams 

icons are visible on the panel without 

tapping the + icon.  

3. A link will be added to the email body.  

4. To rename the meeting link, press on 

the link. 

  

-Tap Paper Airplane icon to Send.  
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Attach a File from DMS or Another File Share 
 

 

  

 

Filing destinations will appear.   

-Tap iManage or another File Share.   

 

 

-Tap Paperclip icon (shown). 

 

 

    

 

-Navigate to the target folder. 

-Or, in the Search box, type: 

- Doc ID  

- Key word(s) in File Name 

-Tap on the file name to attach to the email. 
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Attachment options include: 

-Preview, Delete, Rename  

-In the rectangle, you can select to send the 

attachment as:  

-“Original” (e.g., .docx) 

-“Document Link” (.nrl) or ND link 

-PDF 

 

Here, tap PDF button.  

 

 

File is attached as the original format. Here, .docx.  

For file options, tap the Ellipsis menu.  

Now the file is attached as a PDF.  
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Complete the Email. 

 

Tap the paper airplane to Send.  
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File an Email to DMS Including Predictive Filing 
 

 

Initiate Filing an Email to DMS 

There are multiple ways to initiate filing an email, on either a smartphone or tablet. 

                                       

 

 

 

 

 

 

 

 

 

 

 

 

 

    

 

  

 

 

1. From the open email, 

tap the Folder+ icon.  

2. From the Inbox, swipe 

left on the email and tap 

File.   

 

3.  File multiple emails at once by 

checking several boxes.    

Then, tap the Folder+ icon. 

Or, swipe on one of the checked 

emails and select File.  

 

 

 
Tap: 

-Recommended folder or 

-Recent folder. 

Or file manually. See below.  

 

Note on Predictive Filing: 

Once you file an email with a correspondent 2 or 3 times, Link 

will offer a Recommended folder based on your history.  

 

https://vimeo.com/manage/videos/810720048
https://vimeo.com/manage/videos/810720048
https://mobilehelix.atlassian.net/l/cp/teHgKMNq
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Manual Filing to DMS 
 

 

Initiate the filing as shown above. 

 

 

 

 

 

Now in DMS in LINK, you 

can either navigate to the 

target folder. Or search for 

the Client by typing the 

Client name in the Search 

bar.  

From the filing screen, 

scroll down to “Filing 

Destinations.” 

Tap on the target DMS or 

file share.  

 

 

 

https://vimeo.com/707588371
https://vimeo.com/707588371
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Navigate or Search to the Target DMS Folder 

                      

 

  

      

   

 

Email Filed to DMS - Indicator  

 

 

 
  

 

 

Tap “File Here.” 

Your email is filed.  

Navigate to the target Email 

folder.  

Tap on it.  

 

 

Emails which are filed to DMS have a green checkmark in the 

Inbox.  

 

Note: To remove or keep emails filed to DMS in your Inbox, 

go to Email Settings. 

 

More on Email Settings 

https://mobilehelix.atlassian.net/l/cp/SDM3rPak


 

Mobile Helix, Inc.  Page 62 of 80 LINK User Guide 4.1 

 

File an Email to an Outlook Folder 
 

There are multiple ways to initiate filing an email, on either a smartphone or tablet. 

 

 

                            

  

 

 

 
  

 

  

F 

1. From the open email, 

tap the Folder+ icon.  

2. From the Inbox, swipe 

left on the email and tap 

File.   

 

3.  File multiple emails at once by 

checking several boxes.    

Then, tap the Folder+ icon. 

Or, swipe on one of the checked 

emails and select File.  
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On the Filing screen… 

                           

 

 

 

 

                                   

  

In the Search box, type a 

few letters of the target 

Outlook folder name.   

Tap on the target folder 

name.  

To manually file, tap on 

“Outlook folders”.  

 

With LINK’s predictive 

filing, the folder may be in 

“Recommended.” 

If so, tap on it to file.  
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Predictive Filing 
 

 
LINK has built-in Predictive Filing to both DMS and Outlook folders. 

After you have filed an email with a correspondent to the same DMS or Outlook folder 2 or 3 times, LINK will suggest a 

Recommended folder on the filing screen. 

You may tap on a Recommended folder or Recent folder or scroll down to Filing Destinations to manually file to 

Inbox/Outlook folders or other file repositories.  

Initiate the filing, as above, by tapping on the Folder icon in an open email or swiping on an email in the inbox and 

tapping File.  

The filing screen below is displayed. You may tap on the Recommended folder to file.  

 

In the Recommended section, tap on the target folder.  Your email is filed.  
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Import an Email Attachment to DMS      
 

    Press on the small triangle.  Tap “Upload file(s).”     Navigate or search to Client/Matter.  

   

       

     

         

 

 

 

 

 

 

Navigate or search to target 

folder or file. 
In target folder, tap, “Save 

Here.” Or, to save to a 

current Doc ID, tap on the 

file. 

To change Doc Class or 

Dept, tap blue text for list.   

You may rename in “New 

Name” field.   

Tap Upload button to check-

in. 

Green checkmark indicates 

file is checked in. 
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Save an Attachment to My Files Local Storage in LINK 

 
 

Press on the small triangle.   Tap on “Add to My Files.”  

 

The file is now saved to My Files in LINK.  

The file may be an Office file, PDF, Visio, DMS link, or media file.  

You may view the file offline or online.  

Also see: My Files.  
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LINK VIP Feature for Managing Your Inbox  
 

       

LINK has its own VIP category in Email. VIPs are key Email correspondents for whom you want to get a special Alert 

sound when their emails arrive.  

You can also Sort and Filter your Inbox by VIP.  

 

A benefit of VIP in LINK Email is that it is very quick to set (or clear) a sender as VIP. For example, if you are expecting a 
key Email from someone, mark that person as a VIP. Then you will hear a special sound when a VIP email arrives. No 
longer need to monitor their email? You may quickly clear their VIP status. 

 
Click here to learn more about using LINK VIP. 

-Set a Sender as a VIP 

-Filter and sort by VIP 

-Setup VIP Email Notification Alerts 

 

                     

            

  

 

 

https://vimeo.com/638473726?
https://vimeo.com/638473726?
https://mobilehelix.atlassian.net/l/cp/b0DKr5Em
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Send-and-File to DMS or Outlook Folders 
 

 

    

    

 

 

 

 

 

 

 

 

 

 

 
  

Compose an email. 

Tap the envelope icon to turn on Send-and-

File. Green is on. 

Tap either paper airplane to send.  

You will then be presented with the filing 

screen below.  

Filing Screen 

To file, tap a folder in: 

-Recommended 

-Recent  

-Filing Destinations – Including DMS and 

Outlook folders 

   

 

More on Filing Here 
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Email Swipe Commands 
 

                                                   

 

 

 

 

 

 

  

Configurable Swipe Menus 

Go to Settings: 

Email Inbox > Gear Icon 

Set 3 right to left swipes. 

Set 2 left to right swipes. 
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Threaded View in Email 
 

Turn on Threaded View in the LINK Email Settings: Email Inbox > Gear Icon> Under Appearance and Navigation: 

Organize mail by thread> Toggle on by tapping “Yes”> Tap the Diskette Icon to save.  

 

          

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

Threaded emails have a counter and an up/down 

carat to the right of the Subject line. 

 

When you act on a threaded email as a single entry 

in the Inbox, the action will apply to the entire 

thread. For example, if you swipe to Trash or File an 

email, that action will be applied to the thread. 

 

To act on a single email, tap the down carat and act 

on the target email only.  

From the open email, tap on the Ellipsis icon to get the 

action menu, below and select your desired action.  

-Delete This Message 

-File This Message 

-Mark This Read 

-Mark This Unread 

Note: There are two counters of 

the number of emails in a thread. 

1. Inbox summary counter: 

does not include sent or 

deleted emails 

2. Counter in email header: 

includes sent and deleted 

emails.  
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Email, Calendar, Contacts, Notes & Tasks 
 

LINK is integrated with Microsoft Exchange. Therefore, all of your Outlook applications are synced with your desktop and 

M365 Outlook.  

 

Email Settings  
 

LINK Email has many user Settings options.  

From the Inbox > Gear icon in upper right  

View the Email Settings Guide in the LINK Document Center 

               

             

 

 

 

 

Contacts, Tasks, & Notes: 
Tap on the More button 
from the Email Inbox.  

https://mobilehelix.atlassian.net/l/cp/YNJJyD1H
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Calendar               
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Calendar Tips 

New Event: Tap Pencil or tap in the calendar body at the planned time.  

To Edit or Cancel Event Made by You: Press-hold on event. 

To Change Your Response to an Event: Press-hold on event. 

Advance Calendar: Swipe right or left in event body.  

 

Learn more about LINK Calendar features here. 

 

 

 

 

 

Icons 

 Shared Calendar Folders 

  Settings Gear 

  Refresh Calendar  

     Search Calendar 

  Go to Date (tap) 

  Day  (Views)     

- Day 

 - Week 

 - Month 

 - Agenda 

 New Calendar Event 

 

 

  

 

CREATE NEW EVENT  

https://mobilehelix.atlassian.net/wiki/x/AYCuCg
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Create a New Calendar Event 

 

  

 

 

 

 

 

You can also add Zoom or Teams meeting link to a calendar event – you can learn more about that here. 

 

Learn how to create a Calendar Event from an Email here. 

 

 

 

 

 

  

Icons 

 X   Close Event  

 Reply, Reply All, Forward 

  Free/Busy Scheduler  

   Save Event 

 

 

  

 

CREATE NEW EVENT  

https://mobilehelix.atlassian.net/wiki/x/AQDNB
https://mobilehelix.atlassian.net/wiki/x/AYDRCg
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View Free / Busy Scheduler 
 

 

. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Add Required and Optional attendees.     

Tap “Free / Busy” icon (calendar with X) shown above.  

 

Learn more about using the Free / Busy Scheduler here. 

 

 

 

 

 

 

 

 

 

  

Tap on the event body to 

return to the New Event 

screen. 

https://mobilehelix.atlassian.net/wiki/x/CQDZCg
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Contacts – Settings and Icons 
 

Contacts Settings – tap the Gear icon in the upper right.  

 

 

 

 

 

 

 

 

  

Icons 

 New Contact 

  Settings Gear 

 Contacts Folders 

 Search by Name 

     Sort Icon 

- By Company 

- Email Address 

- First Name 

- Last Name 

- Full Name 

Tap twice to reverse order.  

 

 

 

 

 

 

  

 

CREATE NEW CONTACT 
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Notes 

 
 

 

 

 

 

 

 

 

 

 

 

 

  

 

Tasks 

 
 

         

 

 

 

 

 

 

 

 

 

 

Icons 

New Note 

  Search by Name 

    Sort   

- Color 

- Subject 

Tap to reverse Sort order.  

 

To Edit a Note: Tap on the Note. 

 

Learn more about using LINK Notes here. 

  

 

 

  

Icons 

New Task 

  Search by Name 

    Sort   

- Completed Date 

- Due Date 

- Completed 

- Priority 

- Start Date 

- Status 

Tap criterion to reverse Sort order.  

To Edit a Task: Tap on the Task. 

 

  

 

 

  

 

 

https://mobilehelix.atlassian.net/wiki/x/AQDgBw
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Face ID   
 

If you are not being prompted for Face ID, check that in iOS Settings, Face ID is toggled on 

Settings > Apps > Link > Toggle on Face ID 

 

 

 

In Android, to turn on Face Recognition: Settings > Biometrics and security > Face Recognition > Register Face  
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Set a Default App in LINK 
 

 

 

 

 

 

 

 

 

 

 

From LINK Home Screen, tap Settings tab.  

 

 

 

 

Select the app to be used as the default. 

Tap Home to save the selection.  

 

 

 

  

What is a Default App in LINK? 

If you set a Default App, when you open the 

LINK app, LINK will open directly to the 

Default App.  

Go to Home Screen Settings to select a 

default app. 
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“Today from LINK” Widget – iOS  
 

“Today from Link” is a widget which displays your appointments for the next 24 hours.  

Tap on an event in Today in LINK to go to it in your LINK calendar.  

                                                        

  

 

 

 

 

              

 

 

                    

 

 

Today in LINK 

From the iOS home screen, 

swipe right to see the 

Widgets page. Tap Edit at the 

bottom.  

Add Today in LINK to Widget 
Screen 
Scroll to bottom of widgets. 

Tap Edit.  

Scroll to the bottom again. 

Tap “Customize.”   

Tap the green “+” to add Today 

in LINK to the widget Screen.  

Tap “Done.”  
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Incoming Caller ID  
 

 

This feature allows LINK to populate the native iOS caller ID database with your Outlook contacts and, if configured, your 

Global Address List.  

 

                    

  

Go to Settings, tap “Phone.”  Select Call Blocking &   Toggle Link to on/green. 

     Identification. 

 

 

 

 

 

 

 

 

 

 


